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KARMA Motif 
What’s new in Version 3.1? 
Revision 14-Jan-2014 © by Stephen Kay 

Overview 

This document is primarily for current owners of KARMA Motif 3.0, who are upgrading and want to 
know the main changes in functionality (other than bug fixes and minor improvements). The 
complete list of bug fixes and changes is available, as always, at the KARMA Motif Software: Release 
Notes forum. 

Uninstall the old version first 

Due to changes in the location of some files and other issues, we could not make an updater that 
installs over the previous version. On Windows, please use “Add/Remove Programs” or “Programs and 
Features” to uninstall the old version, before installing version 3.1. On Mac, you can simply move the 
KARMA Motif folder to the trash, or use the Uninstall feature of the previous installer if you still have it. 
Make sure to back up your data first, especially your modified or custom .kdf files! Also, be aware that when 
launching 3.1 for the first time, you will be performing a “First Launch” and your Preferences will be reset. 

Now supports five different Yamaha instruments 

• Adds support for the Yamaha MOXF, MOX, and 
Motif Rack-XS, to the already supported Motif XF 
and XS Series. 

• All five devices can use the same KARMA Motif 
application and KDF Data files, for 
interchangeable KARMA Performances that run 
on any supported model. 

Supports the latest Mac OS X 

• Now compiled as a Universal application. Runs 
natively on Intel Processors; is now compatible 
with Mac OS X 10.7 Lion, 10.8 Mountain Lion, 
and 10.9 Mavericks. Supports 10.4.11 and 
higher, PPC or Intel. 

• Greatly improved memory size and resource 
usage on the Mac - uses approximately one-half 
to one-third the real and virtual memory. 

• Greatly improved CPU usage on the Mac - fixed 
an issue that would cause the app to peg 1 CPU 
at 100% (while in the background), and would 
cause it to use more CPU when in the 
foreground than necessary.  

Help File, Manual, Tutorials 

• The Help File and Manual (which was incomplete and outdated in the version 3.0 release) is now 
100% complete and up-to-date. The pop-up Tooltips are now 100% complete and up-to-date as 
well. Furthermore, a PDF version of the Help File/Manual (for printing and searching) is now included 
and is also 100% up-to-date. 

• New Tutorials and updated Tutorials have been included in the installation’s Tutorials Folder. And as 
always, you can consult http://karma-lab.com/kmo/docs for the latest revisions and additions. There 
are several more tutorials underway that did not make it in time for the release, which will be 
released there in the near future.  

www.karma-lab.com 

http://www.karma-lab.com/forum/forumdisplay.php?f=281
http://www.karma-lab.com/forum/forumdisplay.php?f=281
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New Features 

• Added a new Phase Activity Display in the Real-Time Controls Editor that displays the length and 
execution of the Phase Pattern for all Modules at the same time – it’s very useful for understanding 
the relationship of the time signatures and forward movement of each Module to the others. The 
area at the top is now switchable between the regular MIDI Activity Display and the new Phase 
Activity Display. The current choice is stored in the Preferences so it remembers the view when you 
re-launch the app. 

 
• Added a [Global Device] setting to the KARMA GE’s Wave-Sequencing Device Type setting, so that 

you can change the type of 
Yamaha the software is working 
with, and all the GEs still work to 
send the correct SysEx to the 
correct Device Type. With this 
change, there is now only one KDF 
file included with the installation, 
“KMO Factory Data 1.kdf,” and it 
works with any of the five 
supported Yamaha models (this is 
explained in more detail below in 
the “Changes in the Factory 
Preload KDF” section.  

• Added a new method of changing scenes in the Remote Mode: Next 
Scene, Previous Scene, and Stored Scene can be used, instead of 
selecting a scene directly by number. For the XS and XF, these are 
added on the SEQ Transport Fast Forward, Rewind, and Locate 
buttons. 

 

• MIDI Setup (Global) Editor > Devices Page: 
Added three more Remote Input Ports, for 
supporting more external controllers 
connected at the same time. 

• Added several different Remote Mode 
“Control Maps” for the support of more 
external devices. The “Motif XF/XS – 
Digital Performer” Map corresponds to the 
3.0 version’s default functionality. 

• Added Control Maps for the Steinberg 
CMC-QC Quick Controller and CMC-PD 
Pad Controller. 

• MIDI Setup (Global) Editor > RTC 
Setup Page: Added an additional 
RTC receive port, for supporting 
more external devices connected 
at the same time. 
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• Tone 1 Knob 5 (AEG Sustain) was not used by the KARMA Performances in version 3.0 because there 
was no CC associated with it (for the XF and XS) – only SysEx. However, since the MOX and the MOXF 
use CC#31 for it, we added the ability to use it in the XF and XS by treating the SysEx as CC#31 – 
therefore, Knob 5 is now functional in Song Mode when on Track 1 for controlling various KARMA 
Modules or Keyboard Layers – and all of the Performance Notes have been updated to reflect this 
change. 

 

Factory KDF File changes (KARMA Performances) 

KDF Conversion 

• Certain changes have been made in the Factory Performance KDF file that we supply. The version of 
the KDF File itself has been changed from 3.0.0.5 to 3.1.0.0, to support various improvements. 

• Any KDF files from the previous version will be converted to KDF 3.1 format the first time they are 
opened (you will see an information dialog stating that the file will be converted.) You can save the 
changes over your previous data, or save the file with a new name if you wish to preserve your older 
data files for any reason. 

New Wave-Sequencing Device Type Setting 

One of the biggest changes is that there is no longer any need to have a different KDF file for a 
different Yamaha model. In the 3.0 release, we provided two different KDF files: 

KMO Factory Data 1-XS.kdf (v3.0 - for the Motif XS) 
KMO Factory Data 1-XF.kdf (v3.0 - for the Motif XF) 

The correct file was automatically loaded during the First Launch based on the connect Yamaha 
model. However, now that the application supports five different Yamaha instruments, some changes 
were made so that only a single file is necessary, and works with all supported Yamaha models: 

KMO Factory Data 1.kdf  (v3.1 - for all supported Yamaha models) 

Detailed explanation: The only reason there were different files was because of the KARMA Wave-
Sequencing feature, which sends specific SysEx (System Exclusive) messages to the synth to change 
waveforms in real-time while the notes are being generated. Each Yamaha model requires different 
SysEx messages specific to that device to change the waveforms. Therefore, in the KARMA GEs 
(Generated Effects) that perform the KARMA Wave-Sequencing, there is a Device Type setting stored 
in the GE that specifies which make and model of device is being controlled. It allows the selection of a 
number of Yamaha and Korg models, which can be wave-sequenced by KARMA. (For example, you 
could be using the software with a Motif XF, and if you happen to have a Korg Kronos, you could send 
the output of a GE to the Kronos and use KARMA Wave-Sequencing on it, by selecting the “Korg 
Kronos” WaveSeq Device Type in the GE Editor > WaveSeq Page.) 

In the 3.0 version, all of the GEs in the “XS” KDF file had the WaveSeq Device Type set to “Motif XS”, 
and all of the GEs in the “XF” KDF File had the Device Type set to “Motif XF” – so that they could work 
with the correct device. Adding support for the MOX and MOXF would have meant two more different 
KDF files. 

Instead, in version 3.1 we added a new Device Type setting in the popup menu, which is [Global 
Device]. This makes the GE use the correct SysEx messages based on the recognized Global Device 
Type in the MIDI Setup (Global) > General Page – in other words, it automatically knows which device 
you are connected to globally, and sends the appropriate SysEx messages when KARMA Wave-
Sequencing. If you are using the software with a Motif XF, it knows that and any GE with a WaveSeq 
Device Type of [Global Device] will send SysEx messages for an XF. If you are using it with an MOX, 
then any GE with a WaveSeq Device Type of [Global Device] will send SysEx messages for an MOX. You 
can even switch the software from one Yamaha Device to another, and the GEs will automatically send 
the correct SysEx messages. 
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Therefore, in the version 3.1 KMO 
Factory Data 1.kdf file, all GEs have 
had the GE Editor > WaveSeq Page > 
Device Type changed to [Global 
Device]. So the same factory data file 
will work with any of the five supported Yamaha instruments. If you make KARMA Wave-Sequencing 
GEs that work on an XS, and you later get an MOXF, they will still work on the MOXF. 

 

If you have your own modified KDF files from version 3.0, and 
you wish to apply this change to all of the GEs globally, you 
can use the GE Editor > WaveSeq Page > Menu Button “Set All 
GEs in KDF to Global Device” command. 

 

 

Other Factory KDF-related changes 

• The two Template Banks at the end of the KDF area have been renamed: 

Template Bank ROM A --> Template Bank A 
Template Bank ROM B --> Template Bank B 

There is no “ROM” concept in KMO; this was left over from Korg versions. 

• Template Bank B Drum Template Banks did not have [As Stored] for the first item in each bank. 

• Adding a new Template Bank does not put “User” in the title. There are no User or ROM Template 
Banks in KARMA Motif - just Template Banks. 

• Updated the KMO Factory Data KDF to have the bank of empty GEs (Bank 13) initialized with the new 
Initialized GE Names that include the RTC Model ID. 

• Made some changes in the default RTC Names, mainly fixing those missing a space before the 
number in double brackets.  

• The following GEs had a Cluster Random Weighting Curve greater than 3, resulting in an empty 
popup menu - this setting is not used in this type of GE so it has no effect on the operation. So this 
has now been fixed in KMO Factory Data 1.kdf. 

1/46 Simple Comp 1 - Phase 1,2    
1/47 Simple Comp 2 - Phase 1    
1/49 Simple Comp 4 - Phase 1     

• Performance “031: Darkness Falls” - swapped the four guitar chords and record scratches on Chord 
Triggers 5-8 and 9-12 to make more sense on the MOX/MOXF Remote Mode. The Performance Notes 
have been updated. 

• Cleaned up the WaveSeq Templates, so that unused rows are turned off. This has no affect on the 
musical output of the data. 

• Mac: Decided to have a “KARMA Data” folder for the Mac version (same as Windows), which is now 
where the single KMO Factory Data 1.kdf file is located. 
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Yamaha Data File changes 

Separate KARMA Yamaha Data Files for each supported model 

We are now providing a separate “KARMA Yamaha Data File” for the each supported device type. 
Please see the newly revised “Installation and First Launch” tutorial for device-specific instructions on 
loading the KARMA Yamaha Data. 

Special note for XF users 

With regards to XF owners, we have now included a .X3A file specifically created for the XF. 

Originally, we only provided the XS file, which can be loaded into the XF as well. However, this causes 
a few problems (none of which actually affect using the XF with KARMA Motif; it’s just better to have a 
native file for the XF). Summary of the problems: 

The XS has 3 USR Voice Banks; the XF has 4 USR Voice Banks. While the XF is completely compatible 
with XS data, Yamaha shifts the actual Voices in each USR bank down by 1 in the XF, so the Voices 
comprising the 3 XS USR Banks are in USR2-USR4 of the XF. USR1 in the XF then contains 128 new 
voices that are specific to the XF. 

So loading our XS format Data File into XF caused these issues: 

- XF USR1 was replaced by XS USR 1 (which is normally XF USR2) 
- XF USR2 was replaced by XS USR 2 (which is normally XF USR3) 
- XF USR4 would be initialized, since there is no XS USR4 in the XS Data File 
  (but it should have stayed as XF USR4). 

Again, this had no affect on using KMO, but it was confusing to some XF owners. 

Therefore, the new XF Data File KMO Factory Data 1.X3A keeps the contents of USR1, USR2, and USR4 
the same as the factory preset; only USR3 (which contains our modified Karma-Lab voices used by the 
64 songs) is replaced, leaving your XF closer to what it is normally. 

Karma-Lab Custom Voices Renamed 

In the version 3.0 release, any custom Karma-Lab User Voices or User Drum Voices had the 
abbreviation [K] at the end of the Voice’s name. With version 3.1, all of the custom Karma-Lab User 
Voices in the Yamaha Data have been renamed to have the [K] at the beginning of the name, to 
facilitate loading and viewing them individually on the MOX and MOXF, where you often cannot see 
the full name with the [K] at the end. Example: 

Version 3.0   Version 3.1 
002 Filter Sweeps [K]  002 [K]Filter Sweeps 

For users of the previous version, it’s not imperative that you update your Yamaha data to this version 
if you’ve already modified it - nothing else has changed, nothing affects the sounds - it’s only the 
names that have been changed. 

New Tutorial “Creating your own Yamaha Data” 

There is now a new tutorial included named “Creating your own KARMA Yamaha Data” that explains 
how to combine our data with your data to create your own file that can include your normal edited 
data and the required KARMA pieces. It also includes a reference table of all custom Karma-Lab Voice 
and Drum Voices used by KARMA Motif. 

Other minor fixes 

Fixed the XS and XF KARMA Yamaha Data Files: had a wrong Voice in USR1 001 (Cosmic Psyche 
(unused edit), instead of Everlasting Glory). 
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Important changes you need to be aware of 

Changed the location of the Performance Notes in a new installation 

Starting with v3.1, the Performance Notes folder is named “Performance Notes” (with a space), and is 
located in the application’s folder: 

Mac OS X: 
~/Applications/KARMA Motif/Performance Notes/ 

Windows XP: 
C:/Program Files/KARMA Motif/Performance Notes/ 

Windows 8, 7, Vista: 
C:/Users/Your Account/Documents/KARMA Motif/Performance Notes/ 

Therefore, if you have modified the Performance Notes in any way, or created any of your own, you 
will need to move those versions to this new location. 

Furthermore, if you have the earlier 3.0 version installed, and you uninstall it the way we recommend 
before installing the new version 3.1, it will not remove the old “PerformanceNotes” folder. If you want 
to clean this up, you need to go manually delete the files, which in a default installation, were located 
at: 

Mac OS X: 
~/Library/Application Support/Karma-Lab/KARMA Motif/PerformanceNotes/ 

Windows XP: 
C:/Documents and Settings/Your Account/Application Data/Karma-Lab/KARMA Motif/PerformanceNotes/ 

Windows 8, 7, Vista: 
C:/Users/Your Account/AppData/Roaming/Karma-Lab/KARMA Motif/PerformanceNotes/ 

You can delete the entire “Karma-Lab” folder at this location containing the Performance Notes. 

Note: the above may be hidden folders depending on your operating system and personal settings. You 
may need to “unhide” them in order to perform the removal of the old Performance Notes. 

Modifications to the Performance Notes 

All 64 Factory Performance Notes documents have been updated to reflect the changes to the Tone 1 
Knob 5 now being available to control the XS and XF. Minor changes related to the MOX and MOXF 
have been included where necessary. Furthermore, the Table of Contents now includes a few 
additional documents, and Remote Mode Diagrams for the MOX and MOXF, and Remote Screen 
explanations for the MOX and MOXF. 

Latch On/Off CC changed 

The default Latch On/Off button CC#31 has been changed to #21, because #31 is used by MOX/MOXF 
for AEG Sustain Level. Therefore, if you have an external controller programmed to control the KARMA 
Latch On/Off button using CC#31, you must change it to use CC#21. Do not change the RTC Setup 
page back to CC#31; this will interact with the Sustain Level CC. 

 

Other changes and improvements 

Menus 

• Removed the Close All item from the File Menu for KMO; it’s not relevant to the single window 
design. 

• Renamed the “Save All Changes (PE/GE/KDF)” command in the File Menu to “Save All Edits 
(Perf/GE/KDF)”.  

• Gave the MIDI Port Manager the key shortcut ‘=‘ on the Window Menu. 
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MIDI Setup (Global) Editor > Sync Page 

Added the ability to filter various MIDI real-time messages.  

When the MOX/MOXF is in EXT sync mode, 
triggering KARMA starts the 1-bar MOX/MOXF 
song that corresponds to the KARMA 
Performance, by sending a MIDI Start message, 
and when it the 1 bar ends in the MOX/MOXF, it 
sends a MIDI Stop message back to the software 
that stops KARMA. The problem here is that the 
MOX/MOXF will not respond to Song Select 
messages (change Performances) unless 
UTILITY “SeqCtrl” is set to “in/out.” For the 
XS/XF, we normally have this set to “out.” So we 
added the ability to filter out specific RT messages in the Sync Editor. This way, for the MOX/MOXF, we 
can set it by default to not send the MIDI Start message. And you may find this useful for other 
purposes. 

Other miscellaneous changes 

• Implemented the ability to create new KDF files with the 
default factory GEs and Templates built-in (which is now the 
recommended method).  

 

• Added another half 
octave to the Virtual 
Keyboard (additional 
computer keys...)  

 
 
 
 
• Changed the “Select Motif Type” dialog to “Select Device Type”.  

• Added a checkbox to the Choose Motif Type Dialog (when used while 
the app is already running, not during first launch) so that you can 
change between multiple connected Yamaha models without closing 
all of the already open ports in the MIDI Port Manager (unless you 
want to). 

 

• Added a special note number (100) to the Remote Mode for controlling the Control Layer in Cycle 
mode, for use with external pad devices. 

• Removed the Chord Display from the top of the GE Editor, since it’s redundant to the one in the Main 
Window, and it doesn’t show the Master Transpose.  

• Made it so the Cluster Random Weighting parameters are grayed out for Gated: Vel CP mode, 
because they don’t do anything, and never have in that mode. 

• Removed the “Cluster Advance Mode” parameter from the GE Editor > CCs Page (when the Phase is 
being used for CCs and not Pitch Patterns), since the parameter does nothing in that case. 

• Made the “Reset All” command in the Vel. Response Menu Button also turn the Curves off. 

• Redid appearance of Copy Note Map dialog to not use a copper background, but to just use the blue 
color scheme like the rest of the dialogs. Also changed tooltips to remove “Table” since we are just 
calling them Note Maps. 

• Changed “Note Map Table Name:” to “Note Map Name:” in the rename Note Map Dialog. 



Page 8 
 

• Changed the title of “Restore Current Note Map...” to “Restore This Note Map...” to match the title in 
the Note Maps Menu Button.  

• Made different titles for Note Map “Transpose By” and “Shift By” dialogs. Also, made the title field in 
the Generic Rename dialogs wider, because it was not displaying the full title “Set Transpose Amount 
(Semitones)”.  

• Renamed Trigger Fill Mode -> Trigger Fill in Dynamic MIDI Destinations menu. 

• Improved the operation of the MIDI Setup Assistant Loop by only querying the ports that are open in 
the MIDI Port Manager instead of all ports. 

• Changed the Performance Editor > Other Page, Yamaha Bank Menu to not show numbers before the 
banks, and to not be affected by the Preferences > Popups tab. Removed “Program Popups Menu” 
section from Preferences > Popups, since it no longer does anything for KMO. 

• When making Initialized GEs, and choosing an RTC Model, add the RTC Model’s Type to the end of 
the name, i.e. “Initialized GE (CL1)”. 

• Added a [Global Device] GE Editor > WaveSeq device type so that you can use a single KDF file with 
any of the 5 supported Yamaha device types instead of having 5 KDF files (explained earlier in this 
document). 

• Added a “Set All GEs To Global Device” utility command to the GE Editor > WaveSeq Page’s Menu 
Button (explained earlier in this document). 

• Changed what happens if you have more than one Yamaha model hooked up and you manually 
change the Global Ports from one Yamaha model to another; instead of asking you whether you 
want to change the Device Type (it makes no sense NOT to), we just change it, set up various related 
ports and inform the user. We also do this for changing the Rack-XS to a regular XS and vice versa. 

• Removed the ability to change Global Device types with the Device Type Menu between different 
Yamaha devices, since it makes no sense and has no use. Therefore, we now enable only the item on 
the menu that matches the detected/connected device. 

 

Bug Fixes 

You can view a complete list of all other fixes in the Release Notes, included with the installation of 
version 3.1 or available at the KARMA Motif Software: Release Notes forum. 

 

We hope you enjoy the KARMA Motif 3.1 update! Good KARMA to you all… 

http://www.karma-lab.com/forum/forumdisplay.php?f=281
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